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Ouvrir FrontPage 
Fichier → Fermer (au cas où une page ou un site est ouvert) 
Fichier → Nouveau → Site Web, afin de créer un nouveau site Web. 
La boîte de dialogue « Nouveau » apparaît. 
Choisir « Site Web normal ». 

 
 Veillez à choisir le bon emplacement pour votre futur site Web. FrontPage 

stocke automatiquement les sites Web dans un dossier appelé « mes sites Web » 
dans le répertoire « Mes Documents ». 

 Les modèles « Site Web normal » et « Site Web vide » permettent de créer 
un site Web vide, sans texte exemple ni images, qui offre un maximum de 
souplesse et de contrôle. 

Pour changer le nom du site Web, faites glisser le pointeur sur l’intitulé existant 
et saisissez-en un nouveau → Cliquez OK pour créer le site. 
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CRÉER LES PAGES EN MODE NAVIGATION 

Dans la barre des affichages, faire apparaître le mode Navigation et créez les 
différentes pages selon l’arborescence. 

 Le mode Navigation présente la structure de navigation des pages Web du 
site et permet d’y travailler. 

Ouvrir la « Page d’accueil » 
Vous devrez obtenir ceci : 
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APPLIQUER UNE IMAGE D’ARRIÈRE-PLAN 

Cliquez dans la page Web à doter d’une image d’arrière-plan (Page d’accueil) → 
Cliquez Format → Arrière-plan. 
La boîte de dialogue « Propriétés de la page » apparaît. 

 
Cochez Image d’arrière-plan, afin d’appliquer un graphisme à l’arrière-plan de la 
page Web → Cliquez Parcourir pour localiser l’image à utiliser. 
La boîte de dialogue « Sélectionner une image d’arrière-plan » apparaît. 
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Sélectionner l’image à utiliser à l’arrière-plan de la page Web → Cliquez OK pour 
valider votre choix. 
Cliquez OK pour appliquer l’image à l’arrière-plan de la page Web. 

CHANGER LA COULEUR D’ARRIÈRE-PLAN 

Pour les autres pages, nous allons appliquer une couleur d’arrière-plan. 

Cliquez dans la page Web à doter d’un arrière-plan coloré → Cliquez Format → 
Arrière-plan. 
La boîte de dialogue « Propriétés de la page » apparaît. 

 
Cliquez la zone Arrière-plan, afin de sélectionner une couleur d’arrière-plan. 
Pour afficher une plus grande palette de couleurs, choisissez Autres couleurs. 
La boîte de dialogue « Autres couleurs » apparaît. 
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Dans notre exemple, nous avons choisi d’appliquer un fond gris de valeur : 
66,66,66 → Cliquez OK pour valider votre choix. 
Dans la boîte de dialogue « Propriétés de la page », cliquez OK, afin de changer 
la couleur de fond de la page Web. 

Retournons sur la « page d’accueil ». 

AJOUTER UNE BORDURE PARTAGÉE 

 Vous pouvez ajouter une bordure partagée à chaque page d’un site Web, en 
vue d’afficher les mêmes informations sur l’ensemble de ces dernières. 

Cliquez Format → Bordures partagées. 
La boîte de dialogue « Bordures partagées » apparaît. 
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Sélectionnez Toutes les pages, afin d’ajouter une bordure partagée à chaque 
page du site et À gauche → OK. 

 Un trait en pointillés indique l’endroit où apparaîtra la bordure partagée dans 
les pages Web. 

AJOUTER UN BOUTON SENSITIF 

 Créez un bouton, appelé bouton sensitif, qui change d’apparence quand les 
visiteurs placent le pointeur dessus. Il s’agit d’un lien que ceux-ci cliquent pour 
afficher une autre page Web. 

Nous allons créer les boutons sensitifs : Page d’accueil, Constellations, Planètes, 
Formulaire et Liens. 

Dans la page Web, cliquez où devra figurer le bouton sensitif. 

 
Cliquez Bouton sensitif pour intégrer un bouton sensitif à la page Web → La 
boîte de dialogue « Propriétés du bouton sensitif » apparaît. 

 
Saisissez le texte à faire figurer sur le bouton → Cliquez Parcourir, afin de 
sélectionner la page Web à afficher quand les visiteurs cliqueront sur le bouton. 

 Veillez à ce que le texte du bouton indique clairement la destination de ce 
dernier aux lecteurs. Bannissez l’expression « Cliquez ici », qui n’évoque pas 
grand chose. 
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La boîte de dialogue « Sélectionner le lien hypertexte du bouton sensitif » 
apparaît. 

 
Cliquez la page en question → Cliquez OK. 

Vous pouvez définir l’effet produit lorsqu’un lecteur pointe un bouton sensitif 
(Couleur, Couleur moyenne, Lumière, Lumière inversée, Lumière faible, Relief, 
Profondeur), changer la couleur du bouton sensitif à l’affichage de la page Web, 
changer la couleur de l’effet, la police du bouton sensitif… 
Cliquez OK pour valider vos choix. 
Pour aligner les boutons appuyer sur entrée. 

AJOUTER UN TEXTE DÉFILANT 

 Le navigateur Web Netscape Navigator est incapable d’afficher 
correctement les textes défilants : il fait apparaître l’inscription, mais celle-ci 
reste statique. 

Dans la page Web, cliquez là où devra figurer le texte défilant → Cliquez  
pour afficher une liste de composants intégrables à la page Web → Choisir 
Texte défilant. 
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La boîte de dialogue « Propriétés du texte défilant » apparaît → Saisissez le 
texte qui devra défiler (BIENVENUE SUR CE SITE !!!). 

 Vous pouvez choisir le côté de la page vers lequel devra défiler le texte, le 
mode de déplacement souhaité pour le texte défilant, le temps s’écoulant entre 
chaque déplacement du texte dans la page Web (Délai), la distance de 
progression du texte défilant à chacun de ses déplacements (Valeur), la couleur 
d’arrière-plan du texte défilant, le défilement continu ou limité du texte. 

 Modes de déplacement possibles d’un texte défilant : 

- Faire défiler : le texte apparaît d’un côté de la page Web, parcourt la 
largeur de l’écran et disparaît de l’autre côté de la page. 

- Faire glisser : le texte apparaît d’un côté de la page Web, parcourt la 
largeur de l’écran et s’immobilise de l’autre côté de la page. 

- Alterner : le texte semble rebondir entre les côtés gauche et droit de la 
page Web. 

 
Cliquez OK pour ajouter le texte défilant à la page Web. 
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AJOUTER UN FOND SONORE 

 Par défaut, le navigateur Web Netscape Navigator ne lit pas les fonds 
sonores associés aux pages Web. 

Double-cliquez la page Web à doter d’un fond sonore. 
Cliquez Fichier → Propriétés. 
La boîte de dialogue « Propriétés de la page » apparaît. 

 Vous pouvez ajouter différents types de bandes son en fond de vos pages 
Web, MIDI et WAVE étant les plus répandus. 

Cliquez l’onglet Général 

 
Cliquez Parcourir, afin de localiser le fichier audio à utiliser comme fond sonore 
sur votre ordinateur. 
La boîte de dialogue « Fond sonore » apparaît. 
Cliquez le fichier audio à utiliser comme fond sonore. 
Cliquez OK pour valider votre choix. 
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Le son peut être lu en continu ou un certain nombre de fois. 
Cliquez OK pour ajouter le fond sonore à la page Web. 

 Les pages Web qui renferment des bandes son s’affichent plus lentement à 
l’écran. Au-delà d’un certain temps de chargement, les visiteurs risquent de se 
lasser et de passer à une autre page. Efforcez-vous par conséquent d’utiliser des 
fichiers audio de petite taille qui se transféreront plus rapidement sur 
l’ordinateur des internautes. 

AJOUTER UNE BANDE VIDÉO 

 Lorsque vous ajoutez une vidéo à une page Web, choisissez de préférence un 
fichier AVI, car la plupart des navigateurs Web reconnaissent ce format. 

 Par défaut, le navigateur Web Netscape Navigator n’affiche pas et ne lit pas 
les bandes vidéo incluses dans les pages Web. 

Dans la page Web, cliquez là où devra figurer la vidéo. 
Cliquez Insertion → Pointez Image → Cliquez Vidéo. 
La boîte de dialogue « Vidéo » apparaît. 
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Cliquez la vidéo à intégrer à la page Web → Cliquez OK pour valider votre choix. 

CHANGER LES PROPRIÉTÉS D’UNE BANDE VIDÉO 

 Vous pouvez définir le nombre de lectures souhaitées et spécifier le moment 
où commencer la lecture. 

Cliquez la bande vidéo à modifier → Cliquez Format → Propriétés. 
La boîte de dialogue « Propriétés de l’image » apparaît. 

 
 La vidéo peut être lue en continu ou un certain nombre de fois. 
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 Quant au démarrage de la vidéo, vous avez le choix entre deux options : 
- À l’ouverture du fichier 
- Au passage de la souris 

 Lorsque les navigateurs Web sont incapables de lire les bandes vidéo, un 
encadré apparaît à l’emplacement de la vidéo dans la page Web. Ainsi vous pouvez 
afficher un texte, renseignant les visiteurs sur la vidéo qu’ils ne peuvent pas 
visualiser. 

 
Cliquez l’onglet Général → tapez le texte à afficher dans les navigateurs Web 
incapables de lire la vidéo « votre navigateur ne peut pas lire ce type de vidéo » 
→ Cliquer OK pour valider vos modifications. 

AJOUTER UN COMPTEUR D’ACCÈS 

 Afin de connaître le nombre de visiteurs sur une page Web, vous pouvez 
ajouter un compteur d’accès. S’il s’élève à 50, cela peut donc signifier qu’une 
personne a affiché 50 fois la page ou que 50 lecteurs ont accédé à cette page. 

Dans la page Web, cliquez là où devra figurer le compteur d’accès. 
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Cliquez  pour afficher une liste des composants intégrables à la page Web → 
Cliquez Compteur d’accès → La boîte de dialogue « Propriétés du compteur 
d’accès » apparaît. 

 Il faut noter que votre compteur d’accès ne pourra fonctionner correctement 
que si les extensions serveur FrontPage sont installées sur votre serveur Web. 

 
Vous pouvez choisir le style du compteur à créer, faire commencer le compteur à 
un nombre précis et indiquez le nombre de chiffres que comportera le compteur. 
Cliquez OK pour créer le compteur d’accès. 

 FrontPage démarre automatiquement les compteurs d’accès à 0. 

La mention [Compteur d’accès] apparaît dans la page Web. 

 Le compteur d’accès n’est visible que dans la page Web publiée. 

DÉFINIR DES MOTS CLÉS POUR UNE PAGE WEB 

 Vous pouvez spécifier des mots clés qui facilitent l’indexation de votre page 
Web par les moteurs de recherche. 

 Lorsqu’un visiteur saisit dans un moteur de recherche des termes 
correspondant à vos mots clés, votre page Web a plus de chances d’apparaître 
dans la liste des résultats de requête. 

Cliquez dans la page Web pour laquelle vous voulez définir des mots clés. 
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Cliquez Fichier → Propriétés → Cliquez l’onglet Personnaliser → Dans la zone 
Variables utilisateur, cliquez Ajouter, afin de définir des mots clés pour la page 
Web. 

 Employez à la fois des termes généraux et spécifiques pour décrire votre 
page Web. Incluez aussi éventuellement des mots mal orthographiés, 
susceptibles d’être saisis par les internautes. 

La boîte de dialogue « Variable de métafichier utilisateur » apparaît → Tapez 
keywords, afin de spécifier que vous désirez définir des mots clés pour la page 
Web → Cliquez la zone Valeur et saisissez les mots clés voulus, en les séparant 
par des virgules. 

 
Cliquez OK pour valider votre saisie. 

 
Cliquez OK pour fermer la boîte de dialogue « Propriétés de la page ». 
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AJOUTER UNE IMAGE 

Dans la page Web, cliquez là où devra figurer l’image → Cliquez . 
La boîte de dialogue « Image » apparaît. 

 
Cliquez l’image à intégrer à la page Web (mail.gif)→ Cliquez OK pour valider 
votre choix. 

CRÉER UN LIEN VERS UNE MESSAGERIE 
ÉLECTRONIQUE 

 Vous pouvez créer dans une page Web un lien qui permette aux lecteurs de 
vous envoyer rapidement un message électronique. 

Sélectionnez le texte ou cliquez l’image que les lecteurs devront cliquer pour 

vous envoyer un message électronique → Cliquez . 
La boîte de dialogue « Créer un lien hypertexte » apparaît → Cliquez Adresse 
électronique, afin de créer un lien vers une messagerie électronique. 
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Entrez l’adresse électronique du destinataire des messages. 

 FrontPage fait automatiquement précéder l’adresse saisie de « mailto : ». 

Cliquez OK pour créer le lien vers la messagerie électronique. 

 
Cliquez OK.  
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Allez sur la page « Liens » 
Vous devrez obtenir ceci : 

 

AJOUTER UN SYMBOLE 

Dans la page Web, cliquez là où devra figurer le symbole → Cliquez Insertion → 
Symbole. 
La boîte de dialogue « Symbole » apparaît. 

 
Cliquez Insérer, afin d’ajouter le symbole dans la page → Cliquez Fermer pour 
quitter la boîte de dialogue « Symbole ». 
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CRÉER UN LIEN VERS UNE AUTRE PAGE WEB 

 Vous pouvez lier un mot, une expression ou une image d’une page Web à une 
autre page sur l’Internet. 

Sélectionnez le texte ou cliquez l’image à lier à une autre page Web → Cliquez 

 → La boîte de dialogue « Créer un lien hypertexte » apparaît. 
Entrez l’adresse de la page située sur le Web dans la zone URL → Cliquez OK 
pour établir le lien. 

 

 
Dans le cadre de destination, choisir « Nouvelle fenêtre ». 
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CRÉER UNE LISTE À PUCES OU NUMÉROTÉE 

 Listes à puces : les listes à puces s’emploient pour des éléments sans ordre 
particulier, comme une liste de produits ou de pages Web. 

 Liste numérotée : les listes numérotées s’utilisent pour des éléments à 
disposer dans un ordre précis, comme une série d’instructions ou une table de 
matières. 

Sélectionnez le texte à convertir en liste à puces. 
Cliquez Format → Cliquez Puces et numéros. 
La boîte de dialogue « Puces et numéros » apparaît → Cliquez l’onglet Puces. 

 
Cliquez le style à employer → Cliquez OK pour valider votre choix. 

AJOUTER UNE TRANSITION ENTRE DES PAGES 

 Vous pouvez enrichir votre page Web d’un effet visuel, appelé transition, qui 
apparaît au moment où les visiteurs affichent et quittent la page. 

 Certains navigateurs Web, comme Netscape Navigator, n’affichent pas la 
transition ajoutée à la page. 

Cliquez dans la page à doter d’une transition. 
Cliquez Format → Cliquez Transitions de page → La boîte de dialogue 
« Transitions de page » apparaît. 
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Choisissez le moment qui devra déclencher la transition, la durée voulue pour la 
transition en secondes et l’effet de transition. 

 Limitez les transitions entre les pages à quelques secondes. Si elles durent 
trop longtemps, certains visiteurs risquent en effet de quitter votre site. 

Cliquez OK pour ajouter la transition à la page Web. 

Allez sur la page « Formulaire » 
Vous devrez obtenir ceci : 
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DÉFINIR UN FORMULAIRE 

 Un formulaire permet de recueillir des informations sur les lecteurs qui 
visitent vos pages Web. 

Dans la page Web, cliquez là où devra figurer la formulaire. 
Cliquez Insertion → Pointez Formulaire → Cliquez Formulaire. 

 Le formulaire apparaît dans la page Web, incluant par défaut des boutons 
Envoyer et Rétablir. 

 Votre formulaire ne pourra fonctionner correctement que si les extensions 
serveur FrontPage sont installées sur votre serveur Web. 

Pour changer le libellé du bouton « Envoyer » ou « Rétablir », double-cliquez le 
bouton à modifier. 
La boîte de dialogue « Propriétés du bouton de commande » apparaît. 

 
Tapez le texte à afficher sur le bouton → Cliquez OK pour valider votre 
modification. 

AJOUTER UNE ZONE DE TEXTE 

 Les zones de texte servent couramment à la saisie de noms et d’adresses 
postales ou électroniques. 

Dans le formulaire, cliquez là où devra figurer la zone de texte → Saisissez le 
texte à faire apparaître à côté de la zone. 
Cliquez Insertion → Pointez Formulaire → Cliquez Zone de texte simple. 
Double-cliquez la zone, afin de modifier ses propriétés → La boîte de dialogue 
« Propriétés de la zone de texte » apparaît → Tapez un nom identifiant la zone 
de texte. Il ne doit pas renfermer d’espace. 
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 Le nom saisi n’apparaît pas dans la page Web. Il identifie simplement les 
données entrées par les lecteurs dans la zone de texte lors de la consultation 
des résultats du formulaire. 

 
Vous pouvez aussi changer la longueur de la zone de texte ou prévoir un texte 
exemple ou des instructions apparaissant par défaut dans la zone à l’affichage de 
la page Web. 
Cliquez OK pour valider vos modifications. 

 Il est possible de créer une zone de texte qui affiche un astérisque (*) à la 
place de chaque caractère saisi par le lecteur : on la qualifie alors de zone pour 
mot de passe. Un tel composant permet aux internautes d’entrer des 
informations confidentielles, comme un mot de passe ou un numéro de carte de 
crédit, sans que d’autres utilisateurs ne voient ces informations. Si vous voulez 
créer une zone pour mot de passe, cliquez Oui en face de l’option Champ mot de 
passe dans la boîte de dialogue Propriétés de la zone de texte. 

AJOUTER UN ESPACE DE TEXTE 

 Un espace de texte est idéal pour recueillir les commentaires ou questions 
des internautes. 

Dans le formulaire, cliquez là où devra figurer l’espace de texte → Saisissez le 
texte à faire apparaître au-dessus de l’espace de texte → Cliquez Insertion → 
Pointez Formulaire → Cliquez Zone de texte déroulante. 
Double-cliquez l’espace de texte, afin de modifier ses propriétés → La boîte de 
dialogue Propriétés de la zone de texte déroulante apparaît. 
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Vous pouvez taper un nom identifiant l’espace de texte (il ne doit pas contenir 
d’espace), inscrire dans la zone « Valeur initiale » un texte exemple ou des 
instructions apparaissant par défaut dans l’espace de texte à l’affichage de la 
page Web. 
Cliquez OK. 

AJOUTER DES CASES À COCHER 

Dans le formulaire, cliquez là où devra figurer une première case à cocher → 
Cliquez Insertion → Pointez Formulaire → Cliquez Case à cocher → Saisissez le 
texte à faire apparaître à côté de la case. 
Double-cliquez la case à cocher ( ), afin de modifier ses propriétés → La boîte 
de dialogue « Propriétés de la case à cocher » apparaît. 

 
Tapez un nom identifiant la case à cocher lors de la consultation des résultats du 
formulaire (il ne doit pas renfermer d’espace), affectez une valeur indiquant si 
cette case a été ou non sélectionnée lors de la consultation des résultats du 
formulaire et vous pouvez indiquer que la case apparaisse cochée ou non dans le 
formulaire. 
Cliquez OK. 
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AJOUTER DES CASES D’OPTION 

 Dans ce cas, les lecteurs ne sélectionneront qu’une option parmi celles 
proposées. 

Dans le formulaire, cliquez là où devra figurer le premier bouton d’option → 
Cliquez Insertion → Pointez Formulaire → Cliquez Case d’option → Saisissez le 
texte à faire apparaître à côté de la case. 
Double-cliquez la case d’option ( ), afin de modifier ses propriétés → La boîte 
de dialogue « Propriétés de la case d’option » apparaît. 

 
Vous devez donner un terme qui décrive le groupe de cases d’option et l’identifie 
lors de la consultation des résultats du formulaire (Nom du groupe), spécifier 
une valeur qui décrive chaque case d’option et identifie celle sélectionnée lors de 
la consultation des résultats du formulaire (Valeur), indiquer si vous désirez que 
la case apparaisse sélectionnée ou non dans le formulaire ; vous ne pouvez activer 
qu’une seule case par groupe (État initial). 
Cliquez OK. 

AJOUTER UN MENU DÉROULANT 

 Une zone de liste déroulante, qui fournit une liste d’éléments entre lesquels 
les lecteurs pourront choisir, s’emploie couramment pour proposer des listes de 
tranches d’âge, des pays et des produits. 

Dans le formulaire, cliquez là où devra figurer la zone de liste déroulante → 
Saisissez le texte à faire apparaître à côté de la zone → Cliquez Insertion → 
Pointez Formulaire → Cliquez Menu déroulant. 
Double-cliquez la zone, afin d’y ajouter des éléments → La boîte de dialogue 
« Propriétés du menu déroulant » apparaît. 
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Vous devez donner un terme qui décrive la zone de liste déroulante et l’identifie 
lors de la consultation des résultats du formulaire (Nom), fournir le libellé de 
chaque élément de la zone de liste déroulante (Choix), et vous pouvez associer à 
chaque élément de la zone de liste déroulante une valeur qui identifie l’option 
sélectionnée lors de la consultation des résultats du formulaire ; vous pouvez par 
exemple utiliser un mot plus précis ou une abréviation (Valeur). 
Cliquez Ajouter, afin d’intégrer un élément à la zone de liste déroulante → La 
boîte de dialogue « Ajouter un choix » apparaît. 

 
Vous pouvez sélectionner par défaut un élément du menu déroulant dans un 
formulaire. Pour cela, cliquez « Sélectionné » → Cliquez OK pour ajouter 
l’élément. 
Cliquez OK pour valider vos choix. 
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OBTENIR LES RÉSULTATS D’UN FORMULAIRE 

 Vous pouvez stocker les résultats d’un formulaire dans un fichier sur votre 
serveur Web. Toute information entrée dans le formulaire par les visiteurs est 
intégrée à ce fichier. 

 Vous pouvez également spécifier une adresse électronique vers laquelle 
transmettre les résultats des formulaires, c’est-à-dire les informations entrées 
dans ces derniers par les lecteurs. Pour profiter de ce service, votre serveur 
Web doit néanmoins être configuré pour cette opération. 

Pour indiquer la manière d’obtenir les résultats du formulaire, cliquez dans ce 
dernier. 
Cliquez Insertion → Pointez Formulaire → Cliquez Propriétés du formulaire → 
La boîte de dialogue « Propriétés du formulaire » apparaît. 

 
 Par défaut, FrontPage stocke le fichier dans le dossier _private de votre site. 

Ce dossier étant masqué, les visiteurs qui parcourent vos pages ne peuvent pas 
en consulter le contenu. 

Pour recevoir les résultats du formulaire par courrier électronique, entrez 
l’adresse électronique de destination. 

 Il est possible de demander à la fois le stockage des résultats du formulaire 
dans un fichier sur votre serveur Web et leur envoi par courrier électronique. 

Pour changer les paramètres du fichier ou des messages électroniques qui 
renferment les résultats du formulaire, cliquez Options. 
La boîte de dialogue « Options d’enregistrement des résultats du formulaire » 
apparaît. 
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Cliquez l’onglet Fichier de résultats, en vue de changer les paramètres du 
fichier stocké sur votre serveur Web → Cliquez le format à utiliser. 

 Si vous choisissez de recevoir les résultats de votre formulaire par courrier 
électronique, vous pouvez spécifier un objet pour chaque message électronique. 

 
Cliquez l’onglet Résultats par courrier électronique, en vue de reconfigurer 
l’envoi des résultats du formulaire par messagerie électronique → Entrez l’objet 
par défaut de tous les messages électroniques que vous recevrez → Cliquez le 
format à utiliser (Choisissez le format le mieux adapté à la finalité des résultats 
du formulaire) → Cliquez OK. 
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Cliquez OK pour valider vos choix. 

 Si vous avez entré une adresse électronique, un message apparaît, indiquant 
que votre ordinateur n’est pas configuré pour transmettre les résultats du 
formulaire par courrier électronique. 

 Ce message concerne uniquement les utilisateurs qui publient leurs pages Web 
depuis leur propre ordinateur. Si vous recourez aux services d’un hébergeur, 
ignorez cette boîte de dialogue → Cliquez Non, afin de conserver l’adresse 
électronique spécifiée précédemment. 

AJOUTER UNE LIGNE HORIZONTALE 

Dans la page Web, cliquez là où devra figurer le trait horizontal → Cliquez 
Insertion → Cliquez Ligne horizontale. 

Allez sur la page « Constellations » 
Vous devrez obtenir ceci : 
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AJOUTER UN ENCHAÎNEMENT D’IMAGES 

 Lorsque vous créez un enchaînement d’images, dans lequel les différents 
graphismes se succèdent sans discontinuer, choisissez des images qui ont 
sensiblement la même taille. 

Dans la page Web, cliquez là où devra figurer l’enchaînement d’images. 

Cliquez  pour afficher une liste des composants intégrables à la page Web → 
Enchaînement d’images → La boîte de dialogue « Propriétés du composant 
Enchaînement d’images » apparaît → Cliquez Ajouter, afin de sélectionner un 
graphisme à faire apparaître dans l’enchaînement. 

 
La boîte de dialogue « Ajouter une image dans l’enchaînement d’images » apparaît 
→ Cliquez l’image à intégrer dans l’enchaînement (double_amas_persee.jpg, 
ET_cassiopee.jpg, m15_pegase.jpg, m24_nuagedusagittaire.jpg, 
m29_cygne_amas_ouvert.jpg, m31_andromede.jpg, m42_nebuleuse_orion.jpg, 
m45_amas_pleiades_taureau.jpg, m65_lion.jpg, 
sagittaire_nebuleuse_de_la_lagune.jpg → Cliquez OK pour valider votre choix. 
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Vous pouvez choisir le nombre de secondes à laisser entre chaque image de 
l’enchaînement, l’effet de transition pour le passage d’une image à une autre de 
l’enchaînement (FrontPage propose les effets Stores horizontaux, Stores 
verticaux, Dissolution, Rectangle intérieur et Rectangle extérieur)… 
Cliquez OK pour intégrer l’enchaînement d’images à la page Web. 

CRÉER UN LIEN VERS UNE ZONE DONNÉE  
D’UNE PAGE WEB 

 Avant de pouvoir établir un lien vers une zone particulière d’une page Web, 
vous devez créer un signet. Ce dernier identifie la partie de la page dont vous 
souhaitez permettre un affichage rapide par les lecteurs. 

Cliquez l’endroit de la page Web que les lecteurs devront pouvoir afficher 
rapidement (ex : Andromède, Cassiopée, …). 

Cliquez Insertion → Cliquez Signet → La boîte de dialogue « Signet » apparaît 
→ Saisissez le nom à donner au signet (Veillez à ce qu’il évoque clairement la 
zone de la page Web) → Cliquez OK pour créer le signet. 
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 Vous devez désormais créer un lien que les lecteurs pourront cliquer pour 

afficher la zone de la page Web balisée par le signet. 

Sélectionnez le texte ou cliquez l’image à lier à la zone de la page Web identifiée 

par le signet créé précédemment → Cliquez . 

La boîte de dialogue « Créer un lien hypertexte » apparaît → Cliquez la page 
Web où figure la zone balisée par un signet → Cliquez Signet → Cliquez le signet 
que devra cibler le texte ou l’image. 

Cliquez OK pour fermer la boîte de dialogue « Créer un lien hypertexte ». 
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Allez à la page « Planètes » 
Vous devrez obtenir ceci : 

 

Création des pages : Mercure, Vénus, Terre, Mars, Jupiter, Saturne, Uranus, 
Neptune et Pluton. Chaque page sera composée d’un tableau : l’explication de la 
planète étant à gauche et la photo de celle-ci à droite. 

Exemple : 
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INSERTION D’UN MENU DÉROULANT 

Afin de créer seulement le menu déroulant, il s’agit de travailler en mode 
normal : 

Cliquez Outils → Options de page → Dans l’onglet général ôter « délimiter 
automatiquement les champs d’un formulaire » → OK. 

Cliquez Insertion → Pointez Formulaire → Cliquez Menu déroulant. 
Double-cliquez sur le menu déroulant. 

 
 

Cliquez sur Ajouter. 

 
Faire de même pour les autres planètes (Vénus, Terre, Mars…) 
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Pour que le menu déroulant soit opérationnel, il faut ajouter du langage HTML 
dans le code source. Celui-ci est accessible en cliquant sur « HTML » dans 
l’onglet d’affichage. 

Créer le menu déroulant en mode normal, puis dans le mode « HTML », rajouter : 

Entre la balise <head> et la balise </head> doit figurer : 

<script language="JavaScript"> 
 
<!-- 
 
function MM_jumpMenu(targ,selObj,restore){ //v3.0 
 
  eval(targ+".location='"+selObj.options[selObj.selectedIndex].value+"'"); 
 
  if (restore) selObj.selectedIndex=0; 
 
} 
 
//--> 
 
</script> 

 Cette fonction contient les instructions à effectuer par le navigateur lorsque 
l’utilisateur sélectionne un objet dans le menu déroulant. 

Entre les balises <body> et </body> rajouter la partie en gras : 

      <p align="center">        
          <select name="menu1" 
onChange="MM_jumpMenu('parent.frames[\'self\']',this,0)" size="1" 
style="font-family: Comic Sans MS"> 
          <option value="./planetes.htm">Planètes :</option> 
          <option value="./mercure.htm">Mercure</option> 
          <option value="./venus.htm">Vénus</option> 
          <option value="./terre.htm">Terre</option> 
          <option value="./mars.htm">Mars</option> 
          <option value="./jupiter.htm">Jupiter</option> 
          <option value="./saturne.htm">Saturne</option> 
          <option value="./uranus.htm">Uranus</option> 
          <option value="./neptune.htm">Neptune</option> 
          <option value="./pluton.htm">Pluton</option> 
        </select> 
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AGRANDISSEMENT D’UNE IMAGE DANS UNE 
NOUVELLE FENÊTRE 

Sur chaque page des planètes nous allons agrandir l’image dans une nouvelle 
fenêtre. 

Sélectionner l’image → Cliquez  pour indiquer le cadre où afficher la page 
Web liée → La boîte de dialogue « Créer un lien hypertexte » apparaît. 
Indiquez le chemin d’accès vers l’image. 
Cliquez Cadre de destination, afin d’indiquer le cadre où afficher la page Web 
liée. 

 
La boîte de dialogue « Cadre de destination » apparaît. 
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Choisir « Nouvelle fenêtre » : La page Web liée apparaît dans une fenêtre 
indépendante du navigateur Web → Cliquez OK pour valider votre choix. 
Cliquez OK pour fermer la boîte de dialogue. 

On obtient ceci par exemple : 

 

BARRE DE DÉFILEMENT HORIZONTALE ET VERTICALE 

Afin de donner de la couleur aux barres de défilement, il est nécessaire d’en 
spécifier les caractéristiques dans le code source. 

Dans le code HTML, il s’agit donc de copier dans le head : 

<style> 
 
  <!-- 
  BODY{ 
  scrollbar-face-color:#FFFF99; 
  scrollbar-arrow-color:#000000; 
  scrollbar-track-color:#FFFFFF; 
  scrollbar-shadow-color:#FFFF99; 
  scrollbar-highlight-color:#FFFFFF; 
  scrollbar-3dlight-color:#FFFF99; 
  scrollbar-darkshadow-Color:#000000; 
} 
--> 
         </style> 
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UN EXEMPLE EN JAVASCRIPT 

Il s’agit d’obtenir dans la barre d’état : « Bienvenue sur ce site ». 
Pour cela, il s’agit d’insérer dans le code HTML de la page d’accueil : 

Dans le head : 

<script LANGUAGE="JavaScript"> 
<!-- 
var str = ""  
      var msg = ""  
      var leftmsg = "" 
 
 
      function defilmsg() 
      { 
      if (msg == "")  
      { 
      str = " "  
      msg = "BIENVENUE SUR CE SITE!              "  
      leftmsg = ""  
      } 
      if (str.length == 1)  
      { 
      while (msg.substring(0, 1) == " ") 
      { 
      leftmsg = leftmsg + str  
      str = msg.substring(0, 1)  
      msg = msg.substring(1, msg.length)  
      } 
      leftmsg = leftmsg + str  
      str = msg.substring(0, 1)  
      msg = msg.substring(1, msg.length)  
      for (var ii = 0; ii < 120; ii++)  
      {str = " " + str}  
      } 
      else 
      { 
      str = str.substring(10, str.length)  
      } 
      window.status = leftmsg + str 
      JSCTimeOutID = window.setTimeout("defilmsg()",80) 
      } 
 
 
//--> 
         </script> 

Dans le body ajoutez : 

onLoad="defilmsg()"> 
 
 
      <p align="center"> <font size="6" face="Arial" color="#800080"><a 
name="BIENVENUE SUR CE SITE!">  
      </a> 
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DÉFINIR UNE SYNTHÈSE POUR UNE PAGE WEB 

 Vous pouvez prévoir une synthèse qui permette aux moteurs de recherche de 
mieux décrire certaines pages Web de votre site. 

Cliquez dans la page Web pour laquelle vous voulez définir une synthèse. 

Cliquez Fichier → Cliquez Propriétés 

La boîte de dialogue « Propriétés de la page » apparaît → Cliquez l’onglet 
Personnaliser → Cliquez dans la zone Variables utilisateur Ajouter, afin de 
définir une synthèse pour la page Web. 

 Limitez cette synthèse à une ou deux phrases, car la plupart des moteurs de 
recherche ne réservent pas plus de trois lignes à ce texte. Soyez par conséquent 
concis mais suffisamment évocateur pour convaincre les internautes de venir 
visiter votre site. 

La boîte de dialogue « Variable de métafichier utilisateur » apparaît → Tapez 
description, afin de spécifier que vous désirez définir une synthèse pour la page 
Web → Cliquez la zone Valeur et saisissez une synthèse pour votre page Web → 
Cliquez OK pour valider votre saisie. 

 

 
Cliquez OK pour fermer la boîte de dialogue Propriétés de la page. 
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EMPÊCHER L’INDEXATION D’UNE PAGE WEB PAR  
LES ROBOTS 

 Il est possible d’empêcher les robots (programmes pour localiser et indexer 
les pages nouvelles sur le Web) d’indexer certaines pages, que vous auriez par 
exemple créées à l’intention exclusive de votre famille, vos amis ou votre société. 

Cliquez dans la page Formulaire, que nous allons prendre comme exemple. 

Cliquez Fichier → Cliquez Propriétés → La boîte de dialogue « Propriétés de la 
page » apparaît → Cliquez l’onglet Personnaliser → Cliquez Ajouter dans la zone 
Variables utilisateur, afin d’ajouter les informations qui empêcheront l’indexation 
de votre page Web. 
La boîte de dialogue Variable de métafichier utilisateur apparaît. 
Tapez robots → Cliquez dans la zone Valeur et saisissez noindex, nofollow. 

- noindex empêche les robots d’indexer votre page Web 
- nofollow empêche d’indexer toute page Web liée à la vôtre. 

 
Cliquez OK pour valider votre saisie. 

 
Cliquez OK pour fermer la boîte de dialogue « Propriétés de la page ». 

 
 43  

 



 

VÉRIFIER LES LIENS 

Cliquez Rapports de manière à afficher le site Web en mode Rapports → . 
Pour faire apparaître la boîte de dialogue « Création de rapports », cliquez sur 
Affichage → barres d’outils → Création de rapports. 
La boîte de dialogue « Vérifier les liens hypertexte » apparaît. 

 
Cliquez Vérifier tous les liens hypertexte, afin de contrôler l’ensemble des 
liens du site Web → Cliquez Démarrer pour commencer la vérification des liens. 
Pour rétablir un quelconque lien rompu de votre site Web, double-cliquez le. 
La boîte de dialogue « Modifier le lien hypertexte » apparaît. 
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